SMS Visio Utils – User Guide

Author: Robert Cowham, Square Mile Systems
Last Updated: 2013/07/31 #12
Version: 1.4.x

Synopsis: This describes the Visio Utilities and shows their usage and function.

Contents:

1 Introduction ........................................................................................................................................... 3
   1.1 Installation ....................................................................................................................................... 3
   1.2 Contact Details ................................................................................................................................ 4
   1.3 Release Notes ................................................................................................................................... 4
2 DC Layout - Laying out cabinets on a page ......................................................................................... 5
   2.1 The final result ................................................................................................................................... 5
   2.2 Create Scaled Page with appropriate Background ........................................................................... 5
   2.3 Setting up a Spreadsheet ............................................................................................................... 6
   2.4 Create a Simple Cabinet Master Shape in your own stencil ......................................................... 6
   2.5 Linking Data to a Spreadsheet ....................................................................................................... 7
   2.6 Resizing all shapes in one action ..................................................................................................... 8
   2.7 Laying out many rows of cabinets in one action ............................................................................ 9
   2.8 DC Layout Options ....................................................................................................................... 10
3 DC Floor Tiles ....................................................................................................................................... 11
   3.1 Create Grid from Shape .................................................................................................................. 11
   3.2 Label Shapes ..................................................................................................................................... 12
      3.2.1 Some example output ................................................................................................................. 13
4 Diagram Linker – linking shapes to pages in other diagrams ......................................................... 14
   4.1 Linking the diagrams ..................................................................................................................... 14
5 Diagram Publisher - Saving pages for the web ................................................................................. 16
   5.1 Learning About Data Graphics ...................................................................................................... 16
   5.2 Apply Data Graphics ...................................................................................................................... 16
   5.3 Saving as HTML or PDF ............................................................................................................... 17
6 Diagram Organizer ............................................................................................................................. 20
   6.1 Selecting Connected Shapes ......................................................................................................... 20
   6.2 Filtering Shapes ............................................................................................................................. 21
   6.3 Selecting Shapes by Data ............................................................................................................. 22
7 Network Organizer ............................................................................................................................ 25
   7.1 Showing and Hiding Ports ............................................................................................................ 26
   7.2 Power Topology Diagrams ........................................................................................................... 27
7.3 Switch Connections ................................................................. 27
8 Miscellaneous ........................................................................... 28
8.1 Remove ShapeNum Event .......................................................... 28
9 About Functions ......................................................................... 29
9.1 Show Help ............................................................................... 29
9.2 Check for Updates .................................................................... 29
9.3 About SMS Visio Utils .............................................................. 29
1 Introduction

This is the User Guide for the SMS Visio Utils addin – a freely available addin from Square Mile Systems.

The main features are:

- **DC Layout** - Automating the resizing of shapes for scaled data center floor plans and automating the layout of cabinets in floor plan diagrams into rows (horizontally or vertically)

- **DC Floor Tiles** – Automating the creation of a grid of shapes such as is often used for floor tiles, as well as the application of a sequence of numbers or letters to selected shapes.

- **Diagram Linker** – Automatically links shapes on the current diagram to pages in “details” diagrams.

- **Diagram Publisher** - Automatically saving diagrams to HTML (web) pages with appropriate data graphics applied to each page

- **Diagram Organizer** - Selecting and filtering hierarchical diagrams of shapes to allow trees or related shapes to be selected, and also filtered (to hide unrelated shapes)

- **Network Organizer** – Laying out connections for network topology diagrams, including automatic spacing, and being able to turn port names on or off – very useful for showing switch or patch panel patching diagrams.

These functions are made available through a Ribbon tab (Visio 2010) or via an Addins menu (Visio 2007). See diagrams below:

Figure 1 - Visio 2010 - the SMS Visio Utils Ribbon. *All commands are available on this ribbon or via the right click menu.*

Figure 2 - Visio 2007 - the SMS Visio Utils Toolbar. *Visio 2007 does not have the ribbon feature so commands are available on a specific toolbar.*

1.1 Installation

Please download (and run) the following file:

SMSVisioUtils-UserGuide.docx
• Setup.exe (the path is documented in the email you will have been sent)

If you run Setup.exe it will validate any prerequisites (e.g. Microsoft .Net Framework 3.5) are present and offer to download them for you if needed.

It will download and run smsvisioutils.exe, which will download and run SMSVisioUtilsSetup.msi

Some users have had spurious warnings from Symantec’s Norton Anti-Virus about our download – this is a false positive due to the relatively small number of times (in internet terms anything less than tens of thousands is a “small” number!) the addin has been downloaded. If you receive this warning then you can try directly downloading SMSVisioUtilsSetup.msi and running that.

Please note that you will require sufficient user permissions to be able to install COM addins in your user profile – you may need to consult with your local systems administrator.

1.2 Contact Details

For support you can email us:

support@squaremilesystems.com

The product web page is:


You are welcome to contact us if you are interested in a custom version of the Addin.

1.3 Release Notes

These are available from our web site:

www.squaremilesystems.com/downloads/SMSVisioUtils/RELNOTES.txt
2 DC Layout - Laying out cabinets on a page

2.1 The final result

![Diagram showing DC layout with cabinets]

Figure 3 – Final floorplan result. *This shows cabinets in a scaled data center drawing. The selected cabinet has shape data associated with it such as Name/Width/Depth – and the shape has been sized appropriately.*

Note that some of the cabinets are different sizes – the selected cabinet (C10) has a width/depth of 800x800mm whereas the cabinets in row A and B are all 800x1000mm. Each cabinet has shape data attached to it with fields such as Cabinet_Width, Cabinet_Depth and Cabinet_Name.

It is fairly easy to resize a few shapes manually (or using the Size&Position window shown above), this becomes more time consuming and error prone if you have hundreds of cabinets, and a reasonable percentage of those are non-standard sizes.

So how do we easily achieve the above?

2.2 Create Scaled Page with appropriate Background

You can create a new page diagram based on one of the standard Visio templates, e.g. Maps and Floor Plans > Floor Plan.

Make sure that you set an appropriate scale (in Visio 2010 right click Page name > Page setup… > Drawing Scale tab) to represent the size of your DC.
Using shapes from the stencil “Walls, Shell and Structure” you can draw room walls, plus other fixtures such as doors and/or windows and put them on a background page.

Put all the appropriate background detail on to a background page and then switch to the foreground page to actually insert cabinets.

2.3 Setting up a Spreadsheet

Create a new spreadsheet with column headers in it. You need to have three columns with the following names (other columns can contain any attributes you have data for):

- Cabinet_Name
- Cabinet_Width
- Cabinet_Depth

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Building</td>
<td>Location</td>
<td>Cabinet_Name</td>
<td>Cabinet_Width</td>
<td>Cabinet_Depth</td>
<td>Height</td>
<td>Spare</td>
<td>Cabinet Function</td>
<td>Supplier</td>
</tr>
<tr>
<td>2</td>
<td>London Data Center Computer Room</td>
<td>A01</td>
<td>800</td>
<td>1000</td>
<td>48</td>
<td>34</td>
<td>Network</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>London Data Center Computer Room</td>
<td>A02</td>
<td>800</td>
<td>1000</td>
<td>48</td>
<td>24</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>London Data Center Computer Room</td>
<td>A03</td>
<td>800</td>
<td>1000</td>
<td>48</td>
<td>10</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>London Data Center Computer Room</td>
<td>A04</td>
<td>800</td>
<td>1000</td>
<td>48</td>
<td>8</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>London Data Center Computer Room</td>
<td>A05</td>
<td>800</td>
<td>1000</td>
<td>48</td>
<td>32</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>London Data Center Computer Room</td>
<td>A06</td>
<td>800</td>
<td>1000</td>
<td>48</td>
<td>48</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>London Data Center Computer Room</td>
<td>A07</td>
<td>800</td>
<td>1000</td>
<td>42</td>
<td>24</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>London Data Center Computer Room</td>
<td>A08</td>
<td>800</td>
<td>1000</td>
<td>42</td>
<td>26</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>London Data Center Computer Room</td>
<td>A09</td>
<td>800</td>
<td>1000</td>
<td>45</td>
<td>26</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>London Data Center Computer Room</td>
<td>A10</td>
<td>800</td>
<td>1000</td>
<td>45</td>
<td>45</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>London Data Center Computer Room</td>
<td>A11</td>
<td>800</td>
<td>1000</td>
<td>48</td>
<td>48</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>London Data Center Computer Room</td>
<td>A12</td>
<td>800</td>
<td>1000</td>
<td>45</td>
<td>45</td>
<td>Server</td>
<td>PRISM</td>
<td></td>
</tr>
</tbody>
</table>

Note that Width and Depth are assumed to be in mm (millimeters) if you are importing to a diagram page which is scaled in metric units, or assumed to be inches if the diagram is scaled in US Units (or Imperial) – see Layout Options section below for ways to change this.

See the Video for how to use the standard Visio “Link Data to Shapes” function to open up your spreadsheet.

2.4 Create a Simple Cabinet Master Shape in your own stencil

From Shapes tab, use More Shapes > New Stencil to create a stencil.

Create a cabinet shape (set it to a default size) and drag and drop it into the stencil – suggest you rename the master shape to “Cabinet”.
2.5 Linking Data to a Spreadsheet

![Image of Visio Utility interface showing linking data to shapes]

**Figure 4 – The process of linking data.** As shown in the video, click Link Data to Shapes on the Data tab and then select your spreadsheet and click Finish.

![Image of Visio Utility interface with linked data and shapes]

**Figure 5 – Put shapes on the page.** Having linked data, we can drag and drop all rows on to the page, thus creating a new shape for each one, together with associated shape data.
2.6 Resizing all shapes in one action

Using the “Resize Horizontal” button on the SMS Utils ribbon tab, we can resize all currently selected cabinets in one action as shown above. This reads the values from the shape data fields Cabinet_Width and Cabinet_Depth.

If your cabinets are in vertical rows, then you will probably want to choose “Resize vertical”. You may wish to do this for only some particular shapes (e.g. PDU shapes where the width is positioned vertically whereas most of the cabinets have width horizontally) – as shown in the drawing in section 1.
2.7  *Laying out many rows of cabinets in one action*

By selecting the option “Left to right, top row first” we get the shapes laid out as shown above. This is not difficult to do manually with only a few shapes, but when you have hundreds of cabinets in a data center it becomes rather more painful!

Note the eight different layout options – some of our customers have several different data centers and a different layout for each one.

The utility uses the shape data field “Cabinet Name” to decide which “row” a cabinet is in (see Layout Options below for how to change this).

The default behaviour is to put cabinets in rows next to each other. In the example shown in the results diagram, the cabinets in row C need to be positioned in smaller groups, spaced around the pillars in the hall.

The accompanying video (see product web page) shows all the steps in more detail, including linking shape data to a spreadsheet.
2.8 DC Layout Options

Figure 6 – Layout options. These are the options for DC Layout, explained below.

Shape Name Property – this is the name of the shape data property that is used to calculate which row or column the “cabinets” should be placed. For cabinets it is usual for this to be “Cabinet Name”.

Gap between rows/cols – the vertical gap between rows, or the horizontal gap if laying out columns. The unit of measurement must be specified in standard Visio abbreviations:

- mm – Millimeters
- cm – Centimeters
- m – Meters
- km – Kilometers
- in – inches
- ft – feet
- mi – miles

For cabinets, it would be unusual to specify something in kilometers or miles!

Size Units – if set to Auto (the default), then this reads the value in Page Setup > Measurement Units. It will use millimeters if the Visio page is scaled in metric units, and inches if the page is scaled in inches, feet or imperial units.

If set to to mm, then suitable values for Cabinet Width/Depth might be 800/1000. If in inches then they might be 32/40.

It can also be directly specified as a particular unit (see dropdown values) independently of how the page is currently scaled.
3 DC Floor Tiles

This module has two functions which are very useful for creating and labeling grids of floor tiles or other basic shapes.

3.1 Create Grid from Shape

![Create Grid from Shape](image)

**Figure 7 – Create Grid from Shape options.** These are the options, explained below. The diagram below shows the result.

**Figure 8 – Newly created grid.** The selected square has been turned into a 5x2 grid with no separation between squares.

**Width/Height Properties** – These show the current dimensions of the selected shape. If you change them then you can click the Resize button to resize the shape to the new dimensions.

**Columns (X)/Rows (Y)** – the number of times to duplicate the shape.

**Extra spacing** – this defaults to 0 (zero). If you set it to a value greater than 0 then the shapes will have extra space between them – so their edges will not be right next to each other.

**Start shape is** – this is one of the following values:

- Top Left Corner – start top left and create a row from left to right and then columns from top to bottom.
- Top Right Corner – right to left, top to bottom
- Bottom Left Corner – left to right, bottom to top
- Bottom Right Corner – right to left, bottom to top
**Apply/Undo** – The Apply button creates the grid. If you then click the Undo button, then the grid will be undone, leaving just the original selected shape. This is useful in case you make a mistake and want to change the number of columns or rows.

### 3.2 Label Shapes

This option makes it very easy to straight forward to label shapes with a sequence of numbers or letters, or a combination. You can also apply a common label or clear all labels from selected shapes.

![Auto-Number/Letter Selected Shapes](image)

**Figure 9 – Auto Number/Letter selected shapes.** Using this option it is easy to apply a simple numbering or lettering scheme to selected shapes – as shown we have number 20 squares 01-20. Numbering them AA-AT would be just as easy, or alternatively “Step 01” to “Step 20” using the Prefix.

Dialog options are:

- **Auto-number/Auto-letter** – Number and letter are as explained below – they enable the appropriate options.

- **Set text** – this allows you to set whatever value is in Prefix Text as the text for all selected shapes. If Prefix Text is blank then it clears the text for all selected shapes which can be useful.

- **Start with** – for numbering this value is the start number, with leading zeroes kept, so you can have 1, 2, 3 or 023, 024 etc.
For Letter sequences this can be any letter A-Z, and you can also have leading letters, e.g. AA, AB, AB, or BCY, BCZ, BDA

**Step** – numeric value between numbers in the sequence (not valid for Lettering), thus creating a sequence 10, 20, 30 is easy.

**Text Prefix** – any text you wish to put on the start of every label, e.g. “Step ” or “1/” or whatever. Remember trailing space if you want it.

**Preview** – shows you the first couple of labels in the current sequence to check you are getting the results you wanted with the combination of other fields.

**Direction** – one of:

- Left->Right
- Right->Left
- Top->Bottom
- Bottom->Top

**Apply / Undo** – perform the labeling, or undo the last labeling action (normal undo also works after you have closed the dialog).

### 3.2.1 Some example output

This shows some of the things you can quickly achieve, especially in combination with the Create Grid function:

**Figure 10** – A set of servers. *Use any shape which has appropriate shape text and label – in this case using auto-letter option and a prefix.*

<table>
<thead>
<tr>
<th>AA</th>
<th>AB</th>
<th>AC</th>
<th>AD</th>
</tr>
</thead>
<tbody>
<tr>
<td>02</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>04</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 11** – DC Floor Tiles. *Typically labelled AA, AB along the top, and 01, 02 down the side. Note we can do right->left and bottom->top easily if needed.*
4 Diagram Linker – linking shapes to pages in other diagrams

This is a powerful feature for automatically creating links from shapes in a Master Visio document to pages within details documents.

An example we often come across – being able to link cabinets in a floor plan to the individual cabinet diagrams within one or more "details" Visio documents.

![Diagram Linker](image)

Figure 12 – Diagram Linker. Cabinet shapes on a floorplan may have multiple hyperlinks inserted to detailed cabinet diagrams as shown above. In this example, the cabinet has shape data where the field “Cabinet Name” is set to “01-02”. If we Ctrl+Click on the shape we see several hyperlinks. By clicking on one of those hyperlinks we open up the detailed cabinet diagram (in a separate Visio documents), and on the corresponding page (01-02).

This allows you to easily create a hierarchy of documents with “drill down” capability from higher level overviews to lower level details.

Examples of such drill down hierarchies include:

- Cabinets on floor plans linking to cabinet (or rack) diagrams
- Rack diagrams linking to hardware build of chassis devices
- High level network diagrams to lower level detailed diagrams
- Service diagrams linking to detailed functional architectures
- Process charts
- Making it easy for non-experts to find the detail they want

Other reasons for linking diagrams include:

- Breaking down large Visio files into more manageable smaller ones
- Separating overview and detail diagrams to support information security requirements (restricting access to details for some people)
- Dividing responsibilities for maintaining a set of diagrams among local groups

4.1 Linking the diagrams

Select the “Link to sub-diagrams” option from the SMS Utils toolbar as shown below:
Master file – this is the name of the current Visio diagram – it cannot be changed (although you can open a new Visio diagram and perform the Link action from that diagram).

Current Page/All Pages – you can select which pages in the current document to process.

Link property – this is populated with a list of all possible shape data property names that you can select. In this example the field “Cabinet Name” will be used (the default).

Link prefix – this is the name for the hyperlinks inserted. If multiple details files are selected, then a numeric value is appended to this prefix.

Detail files – browse to select one or more details files to parse. These files are not modified in any way. The module just reads them to find a list of all the page names which match the selected “Link property”.

Use relative pathnames – If checked, and the details file is in the same directory as the master file, then just the filename (without its full directory path) will be used for the link. This allows you to move both files to another directory and have links work correctly.

Clicking the link button will perform the linking and update the progress bar at the same time:

**Figure 13 – Diagram Linker dialog.** These are the options as explained below.

**Figure 14 – Diagram linking complete.** This shows you how many hyper links were created.

It is possible to use Edit > Undo to remove all the added hyperlinks in one action.
5 Diagram Publisher - Saving pages for the web

When you use “Save As...” to create a web page, Visio allows you to save one or more pages in the current document as they are currently shown.

However, if you have shape data then you may use data graphics so that the same diagram can show data in various different ways. For example:

The above diagram shows the same cabinets with 3 different data graphics applied:

- **Cabinet Function** - it is very common to allocate a whole rack to a particular function such as Network equipment or server equipment (for cabling and patching purposes).

- **Power Feed Status** – the first bar shows the design limits in Amps, while the second bar shows current usage – indicates cabinets that may be approaching their limits

- **Power Status** – shows the sum of power (in Watts) for the equipment they contain, and whether that exceeds the design limits

5.1 Learning About Data Graphics

There are plenty of articles and it is well covered in various Visio books. You can start with:


5.2 Apply Data Graphics

The “Apply Data Graphics" button brings up the dialog below:
Figure 15 – Apply Data Graphics. *This button allows you to specify which of the various data graphics defined in the current document should be applied to each page in the document.*

This can be very useful function, particularly if you have a document with many pages and wish to apply a data graphic to each of the pages in the document.

### 5.3 Saving as HTML or PDF

If you have multiple data graphics in your Visio diagrams, then to save as a web page, you would need to manually apply the data graphics and then click save, each time remembering to use a different file name. This can be painful if:

- You have multiple pages each of which has several different applicable data graphics
- You have a few data graphics in the document but many pages, e.g. a diagram containing server racks at one per page, with tens or hundreds of pages

The SMS Utils “Save as Web/PDF” button brings up the following dialog:
Each page is shown in the hierarchy, and for each page, it automatically lists the names of the applicable data graphics (it detects automatically which data graphics are applicable/not applicable to a particular page).

You can easily select any or all of the combinations and then click Save to have each page saved once for each data graphic applied.
If you select the tab “By Data Graphic”, then data graphics are at the top level, and each node lists all pages in the document.

If you select the option “Single File (all pages)”, then the data graphic will be applied to all pages in the document, but the saved HTML page will contain sub-pages for each page within the document. This can be a very convenient option.
6 Diagram Organizer

This set of functions is very useful for reorganizing larger diagrams – typically topology diagrams – where there may be many tens or hundreds of shapes present.

6.1 Selecting Connected Shapes

These functions allow you to select a tree of components which you can then copy and paste or move around to re-organise your drawing. It is also easy to change the format of shape lines for selected shapes to graphically show impact/dependency as shown in the diagram below.

The functions are available on the right click menu for a shape as shown above.
Downwards (Viewing dependencies)

Upwards (Viewing Impact)

Figure 17 – Part of a Service Map showing “downwards” dependencies. This shows a simple mapping of the relationships between a business application (ISA Payment) and the underlying software and servers that support it. The red dashed links show direct dependencies for this service. So at the bottom we have SV-BHAM-010301 and UK_BIRM_BLADE_01.

In this instance we selected children and connectors of the top item and changed the line style.

Figure 18 – Part of a Service Map showing “Upwards” impacts. In this example, a problem with UK_BIRM_BLADE_01 at the bottom might affect multiple business applications (Workflow Client, ISA Payment etc).

In this instance we selected parents and connectors of the top item and changed the line style.

The Filter > View Connected option will first select all connected shapes (parents, children and connectors) and put them on to a special layer. It will then turn off all the other layers in the document.

Filter > Remove Filter undoes the changes in layers.

Please note that the Filter commands will change the current document as they assign shapes to particular layers (Filter/Nonfilter). You may wish to avoid saving the document after applying these options – they are useful for interactive display of results.

6.2 Filtering Shapes

This function can be quite powerful to hide all the shapes that are not directly connected to the selected shapes. It works by selecting all the parents and children
of the selected shape(s) and putting them on to a layer called Filter, it then puts all other shapes on the page onto a layer called NonFilter and hides that layer.

Remember to undo the filter before saving your document.

![Filtering a diagram](image)

**Figure 19 – Filtering a diagram.** This shows the diagram after filtering to only view shapes directly connected (parents or children) with the currently selected shape.

### 6.3 Selecting Shapes by Data

This function is very useful for selecting shapes by the value of any of the shape data fields that they contain.

Being able to select shapes allows you to do things like:

- Change colours, or text or line styles
- Change the layer
- Copy and paste a set of objects into another page or diagram

If you have tens or hundreds of shapes in a large diagram then this can become very useful, especially if the shapes are distributed around the page making it hard or error prone to manually shift click and select them.

![Select by Data options](image)

**Figure 20 – Select by Data options.** These are the options for Select by data, explained below.
Name – this is the name of one of the shape data fields (the drop down is populated with a list of all possible values found in shapes on the page.

Criteria – this is one of “Equals”, “Does not equal”, “Starts with”, “Ends with”, “Contains”, “Does not contain”

Value - this is the string value to compare with.

All Shapes on Page – this button selects from all the shapes on the page (ignoring any existing selection).

Use Existing Selection – this performs a filter to the currently selected shapes (rather than to all shapes on the page). It allows you to drill down quickly and easily to smaller subset of shapes, for example selecting first by field X and then by field Y.

Previous selections – contains a drop down of the last 20 selections made – makes it easier to re-run recent actions.

Figure 21 – Field Names. These include all shape data fields found in shapes on the page.

Figure 22 – After Selecting. This has selected all shapes where field ci_name starts with “account” – in this case 3 shapes (also shown in the Status bar).
Figure 23 – With larger diagrams. This has selected all shapes where field ci_group equals “3-Software” – some 21 shapes spread around the diagram – we might want to change the fill colour of all these shapes, or their width and height in one action.
7 Network Organizer

This is a very powerful tool for laying out diagrams such as network topologies, especially where there are multiple connections between individual shapes.

![Diagram showing network topology with connections]

**Figure 24 – Laying out a switch diagram.** The switches have multiple connections between each other, each on different ports. Using Network Organizer’s Layout Connections option, we have spaced the connections appropriately to the best side of each shape.

It is very common to have multiple connections between switches but it is often hard to draw such diagrams manually:

- It is time consuming to create multiple connections and setup up appropriate Visio connection points for each shape
- If the network changes and you want to add or delete connections, then you need to change the spacing on your connectors – again this is painful if you do it manually
- Changing the layout – moving shapes around the page – also requires you to adjust connector spacing to ensure good layout

The Layout Connections button does this automatically:

- Select the shapes to layout (Ctrl+A to select all shapes on the page)
- Click Layout Connections
If you change the relative positioning of a couple of shapes you can adjust their layout just by selecting the shapes that changed before clicking Layout Connections.

Figure 25 – Changing the layout of a diagram. In this example we have moved SW-BHAM-CORE3 from left to right. By clicking Layout Connections, we automatically moved the connections from the left side to the right side of SW-BHAM-CORE2, and adjusted the relevant spacing on each side.

7.1 Showing and Hiding Ports

We have used a custom connector with shape data to make it easy to Show or Hide all the ports in a diagram.

Figure 26 – Hiding (or showing) ports. The connector shapes have a menu option for this.

Note that this specific example uses the shape data fields produced by AssetGen’s Connect product – but the same principles can be applied to other sources of the information.
7.2 Power Topology Diagrams

This type of diagram which shows power distribution in a data center from PDU to power strips to servers, can be very useful.

The more connectors you have (power strips and servers for example), the more you need Layout Connections.

7.3 Switch Connections

It is common to draw diagrams showing devices connected to a switch or patch panel – easy with Layout Connections.

In the example above, we have used a data graphic to show the cable ids for each patch cable (requires the data to be maintained – in this case done by AssetGen Connect).

This makes for powerful audit tools, or you can produce design documents which are very easy to use as complete build instructions.
8 Miscellaneous

8.1 Remove ShapeNum Event

The Visio Shape Numbering addin (in 2010 available from View > Add-Ons > Visio Extras > Number Shapes) can be tremendously useful.

Unfortunately it has a side effect, in that it adds a Persistent Event to the Visio document which turns out to be remarkably difficult to remove!

If the document is saved Read-Only then you will get the following error message if you open it again within Visio:

The event is visible if you turn on Developer tab and look at “Persistent Events”:
While you should be able to delete it from this dialog, it doesn’t always work.

The SMS Visio Utils button “Remove ShapeNum Event” will correctly remove the event.

9 About Functions

These are available from the last group on the ribbon:

9.1 Show Help

Displays this help document in your currently installed PDF reader.

9.2 Check for Updates

Communicates with the Square Mile Systems web server to see if there is a newer version of the addin.

9.3 About SMS Visio Utils

Displays version information – may be required if you have any support needs.